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Total Number of Questions : 100 Time : 90 Minutes

           Maximum Marks : 100

Question Booklet Sl. No.

INSTruCTIoNS To CANdIdATeS

 1. The Question Paper will be given in the form of a Question Booklet. There will be four 
versions of Question Booklets with Question Booklet Alpha Code viz. A, B, C & d.

 2. The Question Booklet Alpha Code will be printed on the top left margin of the facing sheet 
of the Question Booklet. 

 3. The Question Booklet Alpha Code allotted to you will be noted in your seating position in 
the Examination Hall.

 4. If you get a Question Booklet where the alpha code does not match to the allotted alpha 
code in the seating position, please draw the attention of the Invigilator ImmEdIATEly.

 5. The Question Booklet Serial Number is printed on the top right margin of the facing sheet. If your 
Question Booklet is un-numbered, please get it replaced by new Question Booklet with same 
alpha code.

 6. The Question Booklet will be sealed at the middle of the right margin. Candidate should 
not open the Question Booklet, until the indication is given to start answering. 

 7. Immediately after the commencement of the examination, the  candidate should check that 
the Question Booklet supplied to him/her contains all the 100 questions in serial order. The 
Question Booklet does not have unprinted or torn or missing pages and if so he/she should 
bring it to the notice of the Invigilator and get it replaced by a complete booklet with same alpha 
code. This is most important.

 8. A blank sheet of paper is attached to the Question Booklet. This may be used for rough 
work.

 9. Please read carefully all the instructions on the reverse of the Answer Sheet before 
marking your answers.

 10. Each question is provided with four choices (A), (B), (C) and (d) having one correct answer. 
Choose the correct answer and darken the bubble corresponding to the question number 
using Blue or Black Ball Point Pen in the OmR Answer Sheet.

 11. each correct answer carries 1 mark and for each wrong answer 1/3 mark will be 
deducted. No negative mark for unattended questions.

 12. No candidate will be allowed to leave the examination hall till the end of the session and 
without handing over his/her Answer Sheet to the Invigilator. Candidates should ensure 
that the Invigilator has verified all the entries in the Register Number Coding Sheet and 
that the Invigilator has affixed his/her signature in the space provided.

 13. Strict compliance of instructions is essential. Any malpractice or attempt to commit any 
kind of malpractice in the Examination will result in the disqualification of the candidate.
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1. Which are the East flowing Rivers in India ? 

 1. mahanadi 

 2. Narmada 

 3. Ganga 

 4. Tapti 

 A) 1, 2, 3 and 4  B) Only (4, 3 and 1) 

 C) Only (1 and 3)  d) Only (1, 2 and 3) 

2. Who were the prominent lawyers gave up their practices as a part of Non-Cooperation 
Movement ? 

 1. C. Rajagopalachari 

 2. Subhash Chandra Bose 

 3. mothilal Nehru 

 4. C. R. das 

 A) Only (1 and 3) B) Only (1, 2 and 4) 

 C) Only (1, 3 and 4)  d) All of the above 

3. Identifies the following words related to which dynasty : 
‘Koyil Adhikarikal’, ‘Aayiram’ and ‘Naaluthali’  

 1. Ay dynasty 

 2. Venad dynasty 

 3. Ezhimala dynasty 

 4. Perumal dynasty 

 A) Only (1 and 2) B) Only (2 and 4) 

 C) Only 4 d) All of the above 

4. Match the following : 

 1. Kola Swarupam   a. Venad 

 2. Nediyiruppu Swarupam b. Kochi 

 3. Perumpadappu Swarupam  c. Eranadu 

 4. Trippappur Swarupam  d. Kolathunadu 

 A) 1 – a, 2 – c, 3 – b, 4 – d  

 B) 1 – d, 2 – c, 3 – b, 4 – a

 C) 1 – c, 2 – b, 3 – a, 4 – d  

 d) 1 – b, 2 – c, 3 – d, 4 – a 
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5. Which of the following works included in the Manipravalam literature ? 

 1. Njanappana 

 2. Chandrolsavam

 3. Vaisika Tantram 

 4. Ananthapuravarnnannam 

 A) Only (1 and 2) B) Only (2, 3 and 4) 

 C) Only (1, 3 and 4)  d) All of the above 

6. Examine the following statements as true :

 1. Khariff period starts from November. 

 2. Rabi period starts from July. 

 3. Zaid period starts from June. 

 4. Bajra, Ragi and Jowar are millets. 

 A) All of the above  B) Only (1 and 2) 

 C) Only (1 and 3) d) Only (1, 3 and 4) 

7. Match the following : 

 1. Narora  a. Rajasthan 

 2. Koodamkulam  b. Uttar Pradesh 

 3. Kaiga  c. Tamil Nadu 

 4. Ravatbhatta  d. Karnataka 

 A) 1 – a, 2 – c, 3 – b, 4 – d 

 B) 1 – b, 2 – c, 3 – d, 4 – a

 C) 1 – b, 2 – c, 3 – a, 4 – d

 d) 1 – c, 2 – b, 3 – a, 4 – d

8. Which of the following belongs to tribal revolt against the Britishers ? 

 1. Bhil Revolt 

 2. Kurichiya Revolt 

 3. RIN Revolt 

 4. Santhal Rebellion 

 A) Only (1 and 2)  B) Only (2 and 4)

 C) Only (1, 2 and 4) d) All of the above 
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9. Identify the organisations and its founders.

 1. Athmavidya Sangam  a. Pandit K. P. Karuppan 

 2. Prathyaksha Raksha daiva Sabha  b. Vaikunda Swamikal  

 3. Araya Samajam  c. Vagbhatanandan 

 4. Samathwa Samajam  d. Kumara Gurudevan 

 A) 1 – a, 2 – c, 3 – d, 4 – b  

 B) 1 – c, 2 – d, 3 – a, 4 – b

 C) 1 – b, 2 – c, 3 – d, 4 – a  

 d) 1 – a, 2 – b, 3 – c, 4 – d 

10. Who got the man of the Match award of the T20 final held at Barbados in 2024 ?  

 A) Rohit Sharma   B) Jasprit Bumrah

 C) Virat Kohli d) Heinrich Klaasen

11. Find the odd one.

 A) PS/2 B) SmPS C) USB d) VGA

12. Which is the fastest memory in a computer ?

 A) ROm B) RAm C) CACHE d) BIOS

13. Which of the following statements is/are correct ?

 i. The OS manages all the resources of a computer.

 ii. The OS provides an interface to the user.

 iii. The program execution order is decided by the OS when multiple application 
programs need to be run.

 A) Only ii B) Only i and ii

 C) Only ii and iii d) All of the above (i, ii and iii)

14. A translator is a software that converts a program code from

 A) High-level language to Unicode

 B) High-level language to ASCII

 C) High-level language to machine language

 d) High-level language to Assembly language

15. In which Windows version, Microsoft introduced the Start Menu ?

 A) Windows 8 B) Windows 95

 C) Windows 7 d) Windows XP
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16. Which of the following is not a Web Browser ?

 A) Google Chrome B) mozilla Firefox

 C) Netscape Navigator d) microsoft Outlook Express

17. What is the storage capacity of a standard DVD ROM ?

 A) 4.7 GB B) 2.2 GB C) 700 mB d) 900 mB

18. Which is the correct method to select a paragraph in Microsoft Word 2007 ?

 A) Shift + click anywhere in the paragraph

 B) double click anywhere in the paragraph

 C) Ctrl + click anywhere in the paragraph

 d) Triple click anywhere in the paragraph

19. Which tool is a part of the Clipboard Group in Word 2007 ?

 A) Format painter B) Shapes C) Smart Art d) Page Break

20. Which of the following option is not a paragraph formatting option in Word 2007 ? 

 A) Alignment B) Spacing C) Indentation d) Orientation

21. What is happening when enabling kerning for fonts option in Word ?

 A) Stretches the selected characters vertically

 B) Adjust the spacing between particular pairs of letters

 C) Scale the text horizontally

 d) lowered the letter position by selected points

22. Which of the following statements is/are true in the aspects of templates in mS Word 

2007 ?

 i. Can create a template from an existing document.

 ii. Can create a template from an existing template.

 iii. Can create a macro enabled template.

 A) Only i B) Only i and ii

 C) Only i and iii d) All of the above (i, ii and iii)

23. What maximum levels are supported in a multilevel list in a Word 2007 ?

 A) 7 B) 8 C) 9 d) 10
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 24. Which of the below option is not listed under the “Select Recipients” command in the 
“Start Mail Merge” group for mail merge ?

 A) Import from a CSV file   B) Choose from Outlook Contacts
 C) Type a New list   d) Use an Existing list

 25. In Word, the feature Gutter margin is used for 
 A) To insert numbers in the margin
 B) To manage better document binding
 C) To insert images and shapes
 d) To improve printing quality

 26. Which shortcut key is used to paste the copied content in Word ?
 A) Ctrl + Shift + P B) Shift + T C) Ctrl + V d) Alt + C

 27. Which text wrapping style wraps the text around the graphic in an irregular shape 
bounding the actual image in Word ?

 A) In line with Text B) Tight C) Square d) Through

 28. Which of the below option helps the users to insert a large capital letter used as a 
decorative element at the beginning of a paragraph ?

 A) drop Caps B) Word Art C) Symbols d) Header

 29. What is the size of an A4 paper ?
 A) 148.5 mm × 210 mm   B) 210 mm × 297 mm
 C) 105 mm × 148.5 mm   d) 297 mm × 420 mm

 30. What command is used to assign a name to a specific point in a Word document ?
 A) Header   B) macro
 C) Page Number   d) Bookmark

 31. How does the shortcut key Ctrl + I in Word works ?
 A) makes the selected text italic B) Increase the font size
 C) Add an indent to left   d) Capitalize the selected text

 32. Which of the following is not a method for creating a table in Word 2007 ?
 A) Using the Insert Table command
 B) drawing the table with the mouse
 C) Using the Convert Text to Table command
 d) Using shortcut key Ctrl + T
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33. Which of the following is a way to insert a page break in Word 2007 ?
 i. Pressing Ctrl + Enter.
 ii. double-click on the left mouse button.
 iii. Selecting the Page Break command from the Insert tab.
 A) Only iii B) Both i and iii 
 C) Both ii and iii   d) All of the above

34. How do you secure a document from editing in Word 2007 using a password ?
 A) Click on the “Review” tab, then click on “Protect document”
 B) Click on the “View” tab, then click on “Encrypt document”
 C) Press Ctrl + P
 d) None of the above

35. Which of the following tabs contains the option to create charts in Excel 2007 ?
 A) Home B) Insert C) Pagelayout d) Review

36. Which of the following functions can be used to find the highest value in a range of 
cells in Excel 2007 ?

 A) TOP B) mAX C) COUNT d) SQRT

37. In Excel 2007, what is the maximum number of rows in a worksheet ?
 A) 16384 B) 44165 C) 65536 d) 100000

38. In Excel 2007, what is the keyboard shortcut to delete a selected row ?
 A) Shift + d B) Ctrl + – C) Alt + R d) Shift + Alt + X

39. Which of the following options allows you to Freeze Panes in Excel 2007 ?
 A) Click on the view tab and select Freeze Panes
 B) Right-click on the row or column header and select Freeze Panes
 C) Select a row or column and press Alt + F + P keys
 d) None of the above

40. Which of the following Excel 2007 features is used to analyse data by creating  tables 
and charts based on it ?

 A) Goal Seek B) Conditional Formatting
 C) Thesaurus d) PivotTable 

41. Which of the following chart types in Excel 2007 is best suited for displaying trends 
over time ? 

 A) Pie chart  B) Column chart  C) line chart  d) Scatter chart 



A -9- 

132/25 – K

42. Which Excel 2007 feature is used to create a formula that adjusts its cell references 
relative to the position of the formula in the worksheet ? 

 A) Relative references    B) Absolute references 

 C) mixed references  d) Circular references 

43. Which of the following is not a valid Excel 2007 function for text manipulation ? 

 A) lEFT  B) RIGHT  C) UPPER  d) CENTRE 

44. What is the purpose of slide transitions in PowerPoint 2007 ? 

 A) To animate objects on a slide 

 B) To move from one slide to the next 

 C) To apply visual effects to a slide 

 d) To modify the layout of a slide 

45. Which of the following is not a type of animation available in PowerPoint 2007 ? 

 A) Entrance  B) Emphasis  C) Exit  d) Rotation 

46. What is the default file extension used by PowerPoint 2007 ? 

 A) .pptx  B) .ppt C) .ppx d) .pptm 

47. What is the purpose of the slide master in PowerPoint 2007 ? 

 A) To add animations to objects on a slide 

 B) To apply formatting to all slides in the presentation 

 C) To insert multimedia files into a presentation 

 d) To set the slide timings for the presentation 

48. What is the keyboard shortcut for starting a slideshow from the beginning in 
PowerPoint 2007 ? 

 A) F1  B) F2  C) F5  d) F9

49. Which of the following is not a way to format the background of a slide in 
PowerPoint 2007 ? 

 A) Using a solid color B) Using a gradient fill 

 C) Using a picture or texture fill  D) Using a 3D effect 

50. What is the keyboard shortcut for adding a hyperlink to text or an object in  
PowerPoint 2007 ? 

 A) Ctrl + K  B) Ctrl + H  C) Ctrl + J  d) Ctrl + l 
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51. For what purpose do we use the line space disengaging lever ?

 1. Paper release

 2. marginal release

 3. Variable line spacing

 4. None of the above

 A) Only 2 B) Only 1  C) Only 4 d) Only 3

52. Which of the following movement is not correct in the case of Ribbon movement ?

 1. lengthwise movement

 2. Step By Step movement

 3. Up and down movement

 4. Automatic Reverse movement

 A) Only 1 B) Only 2 C) Only 4 d) Only 3

53. Which document we use triple line space while typing ?

 1. Office Notes

 2. Commercial Purpose

 3. legal document

 4. None of the above

 A) Only 3 B) Only 2 C) Only 1 d) Only 4 

54. The main part of the dog Block is 

 1. Pinion Wheel

 2. Escapement Wheel

 3. Ratchet Wheel

 4. None of these

 A) Only 1 B) Only 3 C) Only 4 d) Only 2

55. In Proceedings “To address” is given in the 

 1. Top left

 2. Top right

 3. Bottom left

 4. Bottom right

 A) Only 4 B) Only 2 C) Only 3 d) Only 1
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56. Each type bar is having ________ characters. 

 1. 1

 2. 4 

 3. 2

 4. None of these

 A) Only 2 B) Only 4 C) Only 3 d) Only 1

57. Another name of mainspring tension is 

 1. Key tension

 2. Rack tension

 3. Carriage tension

 4. None of these

 A) Only 2 B) Only 4

 C) Only 1 d) Only 3

58. Which key is used to get equal column ?

 1. Space bar

 2. Tab Key

 3. Tabulator

 4. None of these

 A) Only 1 B) Only 2 C) Only 3 d) Only 4

59. dog Block is connected to the

 1. Carriage lever

 2. Back spacer

 3. Non-character key

 4. Character keys

 A) Only 4 B) Only 3 C) Only 1 d) Only 2

60. Universal bar is connected to ___________ of a typewriter.

 1. mainspring

 2. Pinion Wheel

 3. dog Block

 4. Ribbon Gear

 A) Only 1 B) Only 2 C) Only 3 d) Only 4
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61. Fill in the blanks using an appropriate article. 
He waited for ________ hour and a half for lunch.

 A) A B) An
 C) The d) None of these

62. He sat _____ his friend.
 A) Beside B) Besides C) Between d) Along

63. my brother is _________ boy in his class.
 A) Tall B) The tallest C) Taller d) As tall as

64. I saw a ____ of dogs.
 A) Herd B) Pack C) Gang d) Flock

65. Choose the correct passive form of the sentence given below.
 A) The old woman will have helped by him.
 B) The old woman will being helped by him.
 C) The old woman will be helped by him.
 d) The old woman would have helped by him.

66. my friend has too many irons in the fire. (Find out the meaning of the underlined 
idiom)

 A) He is engaged with many problems
 B) He is having many qualities
 C) He is having many drawbacks
 d) He is engaged in too many enterprises at the same time

67. He seemed affected by diffidence. (Identify the antonym of the underlined word)
 A) Confidence B) Valour C) Cleverness D) Seriousness

68. I __________ (attend) the class since 10:00 am.
 A) have attended B) am attending
 C) had attended   d) have been attending

69. I went for a picnic to relieve the tedium of everyday life. (Choose the synonym of the 
underlined word)

 A) Boredom B) Tiredness C) Harshness d) Tension

70. Honour and glory ____ his reward.
 A) are B) is C) have d) were
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71. If they had requested me, I _________ them.

 A) Would help B) Will help

 C) Will have helped d) Would have helped

72. Raju is a person who builds in or works with stone. (Choose one word for the 
words underlined)

 A) Goldsmith B) mason C) Blacksmith d) Carpenter

73. “Call the police”, said the old lady to her son. (Change into Indirect Speech)

 A) The old lady asked her son for calling the police

 B) The old lady commanded her son must call the police

 C) The old lady commanded her son to call the police

 d) The old lady commands her son to call the police

74. Find the correct word from the following words.

 A) ecsentric B) tution C) accommodation d) spacimen

75. Varun’s parents help him to overcome his difficulties. 
(Choose the appropriate phrasal verb of the underlined word)

 A) get through B) get over C) get across d) get along

76. Sachin played well, __________ ? 
(Use appropriate question tag)

 A) did he B) didn’t he C) do he d) don’t he

77. “The door must be kept locked’’ is an example of

 A) Assertive sentence B) Imperative sentence

 C) Exclamatory sentence d) Interrogative sentence

78. Pick out the adjective from the given sentence. 
I am a clever boy.

 A) boy B) a C) clever d) am

79. The gender of the word ‘duchess’ is

 A) masculine B) common C) neuter d) feminine

80. He is neither smart _______ brave.

 A) or B) and C) but d) nor
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81. AÊÜWÜáío®Ü & D ±Ü¨Ü¨Ü A¥Üì
 A) ñÜÇæ¸ÝWÜá B) ÊÜááS±ÜÃÜ¨æ C) Ÿí—ÓÜá d) EÔÃÝo

82. ñÜÈÉà®Ü & D ±Ü¨Ü¨Ü ËíWÜvÜOæ
 A) ñÜÇ… + Èà®Ü B) ñÜí + Èà®Ü C) ñÜñ… + Èà®Ü d) ñÜÇæ + Èà®Ü 

83. PÜË ¨Ü. ÃÝ. ¸æàí¨æÅ¿áÊÜÃÜ PÝÊÜÂ®ÝÊÜá
 A) ÊÜáá¨Üª|¡ B) Aí¹PÝñÜ®Ü¿á¨ÜñÜ¤
 C) B®Üí¨Ü PÜí¨Ü d) ¨ÜáWÝì¨ÝÓÜ 

84. WÜ¨ÜáX®Ü ®Ý|ì±Ü³®Üá ŸÃæ¨Ü PÜê£
 A) PÜOÝìo »ÝÃÜñÜ PÜ¥Ý ÊÜáígÄ B) hæçËá¯ »ÝÃÜñÜ
 C) PÜ¹ºWÜÃÜ PÝÊÜ d) ËàÃæàÍÜ aÜÄñæ 

85. ñÜÙÜÖÜ© & D ±Ü¨Ü¨Ü ±Ü¿Þì¿á ±Ü¨Ü
 A) ÖÜ©Ÿ¨æ B) WÝwWÝ£ C) ±ÜíaÝíWÜ d) ±ÜÅÊÝÖÜ 

86. ÖÜÙÜWÜ®Ü°vÜ¨Ü ¸æàípæ GíŸ ±Ü¨Ü¨Ü ÖæãÓÜWÜ®Ü°vÜ ÃÜã±Ü
 A) ¸æãàípæ B) ±æàpæ C) ¸æàpæ d) ¸æàÃæ 

87. PÜ®Ü°vÜ	APÜÒÃÜÊÜÞÇæ¿áÈÉ	ËÓÜWÜì	ÊÜáñÜá¤	A®ÜáÓÝÌÃÜWÜÙÜ®Üá°	H®æí¨Üá	PÜÃæ¿ááñÝ¤Ãæ	?
 A) ÓÜÌÃÝPÜÒÃÜ	 B) A®Üá®ÝÔPÝPÜÒÃÜ C) ÊÜÂíg®ÝPÜÒÃÜ d) ÁãàWÜÊÝÖÜWÜÙÜá 

88. ±ÜÊÜì & D ±Ü¨Ü¨Ü ñÜ¨Ü½ÊÜ
 A) ±ÝÊÜì B) ÖÝÃÜáÊÜ C) ÖÜŸº d) ±ÜÊÜìñÜ 

89. PæÙÜX®ÜÊÜâWÜÙÜÈÉ	ŸÖÜáÊÜaÜ®Ü	±Ü¨Ü	¿ÞÊÜâ¨Üá	?
 A) ÊÜáWÜÙÜá B) ÊÜáPÜRÙÜá C) ÊÜáWÜ d) ÊæãÊÜá¾WÜ 

90. ÓÜ¨ÜêÍÜÂ & D ±Ü¨Ü¨Ü »ÝÊÜ®ÝÊÜá ±Ü¨Ü 
 A) A¨ÜêÍÜÂ B) ÓÝ¨ÜêÍÜÂ C) A®ÝÂ¨ÜêÍÜÂ d) ¨ÜêÍÜÂ 
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91. ËÁãàWÜ & D ±Ü¨Ü¨Ü ËÃÜá¨Ýœ¥Üì ±Ü¨Ü
 A) ÓÜíÁãàWÜ B) ¿ÞWÜ C) AÁãàWÜ d) ¯ÁãàWÜ 

92. PæÙÜWæ ¯àvÜÇÝ¨Ü ±Ü¨ÜWÜÙÜÈÉ ÓÜÄ¿Þ¨Üá¨Ü®Üá° BÄÔ ŸÃæÀáÄ.
A) ¨æàÖÜ«ÝyÜÂì B) ¨æàÖÜ¨ÝyÜÂì C) ¨æàÖÜ«ÝvÜÂì d) ¨æàÖÜ¨ÝvÜÂì 

93. ÊÜÂÊÜÖÝÃÜ¨Ü E±ÜÁãàWÜPÝRX ÊÜÂQ¤ ÊÜÓÜá¤ ÓÜ§ÙÜWÜÚWæ CÄÓÜÇÝ¨Ü ÖæÓÜÃÜá
 A) ÃÜãyÜ®ÝÊÜá B) AíQñÜ®ÝÊÜá C) A®ÜÌ¥Üì®ÝÊÜá	 d) ÓÜÊÜì®ÝÊÜá 

94. ÊÜáãWÜá ÊÜááÄ¿áá GíŸ »ÝÐÝ ±ÜÅÁãàWÜ¨Ü A¥Üì
 A) ±ÜâÃÜÓÜRÄÓÜá B) —PÜRÄÓÜá C) WÝ¿áWæãÙÜáÛ d) ÖÝÃæçÓÜá 

95. B¨Ý¿áÊÜ®Ü°ÄñÜá ÊÜÂ¿áÊÜÞvÜ¸æàPÜá GíŸ A¥Üì ¯àvÜáÊÜ WÝ¨æ ÊÜÞñÜá
 A) Pæç PæÓÜÃÝ¨ÜÃæ ¸ÝÀá ÊæãÓÜÃÜá B) ÊÜÞw¨ÜáªOæã¡à ÊÜáÖÝÃÝ¿á
 C) ÖÝÔWæ	C¨ÜªÐÜár	PÝÆáaÝaÜá	 d) PÝ¿áPÜÊæà PæçÇÝÓÜ 

96. BPÝÍÜ __________ ÊÜáÙæ¹ñÜá¤	D	ÊÝPÜÂÊÜâ	A¥Üì±Üä|ìÊÝWÜÆá	ŸÙÜÓÜ¸æàPÝ¨Ü	Ë»ÜQ¤	±ÜÅñÜÂ¿á.	
A) E B) A®Üá° C) Cí¨Ü	 d) CWæ

97. PÝÄÃÜáÙÜá & D ±Ü¨Ü¨Ü ËWÜÅÖÜ ÊÝPÜÂ
 A) PÜñÜ¤Æá	CÃÜáÙÜá	 B) PÜÄ¨Üá	CÃÜáÙÜá	 C) PæaÜc®æ	CÃÜáÙÜá	 d) PÝÙ…CÃÜáÙÜá	

98. AÃÜÚ¨Ü	ÊÜáÈÉWæ	ÖÜãË®Ü	aÜ±Ü³ÃÜÊÜâ	¸æÙÜ©íWÜÚ®Üíñæ	PÜíWæãÚÓÜá£¤ñÜá¤	&	D	ÊÝPÜÂ¨ÜÈÉÃÜáÊÜ	AÆíPÝÃÜ
 A) ÃÜã±ÜPÜ B) ¨ÜêÐÝríñÜ	 C) E±ÜÊÜá d) EñæøàPæÒ 

99. ÁáívÜ	Ááw¤	PÜ®Ü°vÜ	±Ü¨ÜWæãÙ…	Aí¨æÅ	ÃÜñÜ°íW…	±ÝÅ|	&	PÜË	i.².	ÃÝgÃÜñÜ°í	D	±Ü¨ÜÂ¨ÜÈÉ	"ÁáívÜ'	
Gí¨Üá	H®Ü®Üá°	E¨æªàÎÓÜáñÝ¤Ãæ	?

 A) WÜívÜ B) ÊÜá¨ÜÂ C) ÖæívÜ£ d) ñÜí¨æ 

100. WÝŸÄÀáí¨Ü	®ÜËà®Ü®Üá	¸æàWÜ¸æàWÜ®æ	ÊÜá®æ¿áPÜvæ	®Üvæ¨Ü®Üá	&	D	ÊÝPÜÂ¨ÜÈÉ	"¸æàWÜ¸æàWÜ®æ '	GíŸá¨Üá	
A) hæãàvÜá±Ü¨Ü B) PÜãvÜá±Ü¨Ü C) ®ÜáwWÜoár	 d) ©ÌÃÜáQ¤
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